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LoRaWAN Network Architecture (1/2)

* Deployed in a star-of-stars

topology
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End Nodes /Gateway Server e Communication between
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LoRaWAN Network Architecture (2/2)
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The Things Network (TTN)

« - C @ thethingsnetwork.org 2 w O &

chir| Sign up

ﬂ L'f,mg‘g: Learn Hardware Forum Communities Conference Enterprise

it
We are a global collaborative ’ .L
Internet of Things ecosystem ' .
that creates networks, devices |-
and solutions using
LoRaWAN®.

Start building

2UVOEOHOC LOTOTOTIOU : Link
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https://www.thethingsnetwork.org/

The Things Network (TT

:,"EETTJ,"E'%S( Learn Hardware Forum Communities Conference Enterprise Login Sign up

. THE THINGS 3 THE THINGS STACK Hag [ mnos W THE THINGS STACK
S HETWORK BB Community Edit [1| | [t BB Cloud

Experimen‘l' and Build, grow and scale with The
Things Stack Cloud

explore with The
Th ing S Neiwork (¥) Out-of-the-box LoRaWAN® Network Server

P

(~) 100% private, secure and isolated network

Get hands-on experience with LoRaWAN® . S ;
Suitable for commercial, industrial use

Support your local loT/LoRaWAN community »99.9% guaranteed uptime

Build and participate in community projects
P P s Advanced network management features

Fair usage policy applies (not suitable for

~) Pays-as-you-go pricing plans
businesses) Y YOU=I0P) 9P

May experience occasional downtimes with no
high availability

Join The Things Network Get started for free

MaveruotApo Awyaiou Tunua Mnxavikwy
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The Things Network (TTN)

THE THINGS
NETWORK

Sign in with The Things ID
Don't have an IDYSign up for free

Email

Password O

Login with The Things ID

Forgot password

MaveruotApo Awyaiou Tunua Mnxavikwy
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The Things Network (TTN)

4
@ THE THINGS ID Username s

icsddXXXXX

Create one ID to get
access to all our
products.

Email «

icsdXXXXX@icsd.aegean.gr

Password e

One secure account for The Things Network and =
future services gathered in one place.

Confirm Password «

RN ] Q

@ By checking this box, you agree to our
Terms and Conditions and Privacy Policy.

Sign up to The Things ID

MaveruotApo Awyaiou Tunua Mnxavikwy
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The Things Network (TTN)

@ THE THINGS ID

Create one ID to get
access to all our
products.

One secure account for The Things Network and
future services gathered in one place.

4

Your ID has been created successfully

A verification email has been sent in your
mailbox.

Back to login screen =

MaveruotApo Awyaiou Tunua Mnxavikwy
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The Things Network (TTN)

THE THINGS
NETWORK

Sign in with The Things ID
Don't have an ID? Sign up for free

icsd XXX XX @icsd.aegean.gr

cerennnnd @‘

Login with The Things ID

Forgot password

MaveruotApo Awyaiou Tunua Mnxavikwy
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The Things Network (TTN)

L"EETT#L';'EF( Learn Hardware Forum Communities Conference Enterprise 9 leftsipis v
47 ‘
,raf:{ My Profile
!;.%’f{ﬁ;”.
il ;.‘*" ;J
/' Console
H
" S  Log Out
We are a global collaborative -

Internet of Things ecosystem

that creates networks, devices |

and solutions using ‘

LoRaWAN®. .. . N

e R U
s

MaveruotApo Awyaiou Tunua Mnxavikwy
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The Things Network (TTN)

2 | The Things Stack Community Edition
mune: | Choose a network cluster

NETWORK

Device or gateway location

Select your ragion v

Existing clusters

Europe 1
eul - Dublin, Ireland

North America 1
nami - California, USA L]

Australia 1 [
zul - Sydney, Australia

Mavemotrpo Awyaiou TuAua Mnxavikwy
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The Things Network (TTN

EUL Community
= @ . .j gregpapsamos ¥

E&i:mmﬁ%ﬁ#ﬁ"‘ B Overview O Applications = Gatewsys aw Organizations

Welcome back, gregpapsamos! ¥

Walk right through to your applications and/or gateways.

Need help? Have a look at our @Documentation @ or Get support®.

i

Go to gateways

Go to applications

Maveruotipo Ayaiou Tunua Mnxavikwyv
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The Things Network (TTN

_ L i bl 18 Overview O Applications 3 &% Organizstions & EUL Community —
THE THINGE e e
NETWOEK o 5LA eppliceble (3

V= » samios-segean-iot

0 samos-asgean-iot

=3

samos-aegean-iot
1Dz eui-act FOBHF=0607b6

= Lvedsts Tagsl V3868 e Lastactivity justnow @ = 2 Collsborat: Or 0 AP keys

<

Location
General information » Livedata

an Collsborstors

D au ] w1
.
Ov APl keys AC 1F 89 FF FE 86 07 86 < | @
o
a General settings MNone .
Oct 1, 2022 11:15:03 AR i
Wl
Oct 1,2022 11:54:35
== . Location

EU_863_&70_TTN

* Download global_confjson

L||.i'\|i:: it

Tdjog

Mutirpiol

Maveruotipo Ayaiou Tunua Mnxavikwyv
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TTN Application

= ]

THE THINGS STACK T S s S e e @ELI:LCommunlt].l
t o Community Edition mll Overview D Applications e Gatewsys = Organizations st
NETWORK

gregpapsamoz

Welcome back, gregpapsamos! ¥

Walk right through to your applications and/or gateways.

Meed help? Have a look at our @Documentation® or Get support®.

[/a)]
i \
ooo
— o | —
— (o) -
\ "
Go to applications Go to gateways

Mavetmiotriplo Alyaiou TuApa Mnxavikwy
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TTN Application

N\ .
: RO = . EU1 Communi
‘ ﬁ Eﬂfr;’:ﬂrﬂﬁs tﬂtﬁl 0§ Overview O Applications o Gateways &k Organizations ® tY_ leftsipis ~
THE THINGS . Fair use policy ap )
HETWORK &
Applications (0} Q, Search + Add application
D % Name % End devices Createdat

No items found

Maveruotipo Ayaiou Tunua Mnxavikwyv
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TTN Application

-\"‘\\
‘ m Eﬂﬁﬂfﬂmﬁfsﬂ{?ﬁ" BE Overview O applications o Gateways = Organizations

THE THINGS

HETWORK

Add application

Application 1D *

tsipisdemoapp

Application name

tsipisdemoapp

Description

tsigisdemoaglj

A
Optional application description; can also be used to save notes about the application

Maveruotipo Ayaiou Tunua Mnxavikwyv
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m tsipisdemoapp

<>

End devices

Live data

Payload formatters

Integrations

Collaborators

Or APl keys

General settings

TTN loT Device

tsipisdemoapp
1D: tsipisdemoapp

No recent activity @

General information

Application ID

Created at

Last updated at

End devices (0]

* Live data
tsipisdemoapp I © 13:41:35
Nov 4,2022 18:41:35
Nov 4,2022 18:41:35
Q, Search

Mame = DevEUI

Maveruotipo Ayaiou Tunua Mnxavikwyv

A 0Enddevices &% 1 Collaborator  ©w 0 APl keys

tsipisdemo.. Create application

See all activity —

= Import end devid

s + Add end device

JoinEU

MAnpodoplakwy Kat ETKOWWVIAKWY ZUCTNHATWY
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TTN loT Device

Community Edition

S .
= EU1 C
.‘ m THE THINGS STACK B3 Overview O Applications o Gateways = Organizations @ ommunity leftsipis ~
THITHING Me support plan &
NETWORK

Applications > tsipisdemoapp > End devices

End devices (0} Q, search =t Impartend devices + Add end device

D = Name = DevEUI JoinEUI Last activity

m tsipisdemoapp

BS  Overview

% Enddevices

No items found
=) Livedata
<> Payload formatters v

X Integrations v

= Collaborators

Maveruotipo Ayaiou Tunua Mnxavikwyv
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TTN loT Device

m tsipisdemoapp

=l Overview

% End devices

=] Livedata

<> Payload formatters
P ntegrations

aw Collaborators
APl keys

ﬂ General settings

< Hide sidebar

End device type

Input Method

Select the end device in the LoRaWAN Device Repository
® Enter end device specifics manually
Frequency plan @ *

w Europe 863-870 MHz [SFS for RX2 - recommended)

w LoRaWAN version (3 *

LoRaWAN Specification 1.0.1

3 *

Regional Parameters version @

Show advanced activation, LoRaWAMN class and cluster settings «

Provisioning information

JoinEUI® *

00 00 0O G0 60 OO B0 ﬂ@l Caonfirm

Maveruotipo Ayaiou TuAua Mnxavikwv
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TTN loT Device

m tsipisdemoapp
Provisioning information

BE Overview JoinEUI 3 *

60 00 60 60 0O B8 00 66 Reset

A End devices This end device can be registered on the network
= Livedata DevEUID
70 B3 D5 7E D@ @5 73 A8 5/50 used
<> Payload formatters v
AppKey @ *

. Int ti w

S, integrations DB DF 17 72 62 A2 C7 46 80 93 FO D4 80 EB 2A BA () Generste
& Collaborators End device ID@) *

eui-70b3d57ed00573a6

g

APl keys
Thiz value is automatically prefilled using the DevEUI

&

General settings After registration
® View registered end device

Register another end device of this type

¢ Hide sidebar Register end device

Mavetmiotrpo Awyaiou TuApa Mnxavikwy
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TTN loT Device

=N .
‘ ST, . st = S EU1 Communi
m g:gfntrmﬁidiﬁf," B overview [ Applications b Gateways &% Organizations ® ty leftsipis ~
HETWORN Fair use policy applies @

Applications » tsipisdemoapp > End devices

m tsipisdemoapp
End devices (1} Q, search =4 Import end devices + Add end device

== Overview

D = Name = DevEUI JoinEUI Last activity
_1. End devices

eui-T0b3d57ed00573a6 7OB3I DS FEDBE5 73 A8 | R 0O 00 00 68 00 BE 00 00 | IR MNever
= Livedata
<2 Payload formatters hd

Maverotipo Ayaiou Tunpa Mnxavikwy
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<>

tsipisdemoapp

Overview

End devices

Live data

Payload formatters

Integrations

Collaborators

API keys

General settings

TTN loT Device

eul-Ivpsusieuavud i 34v
ID: eui-70b3d57ed00573a6

Tnfa < nfa Mo activity yet @

Overview Live data Messaging Location Payload formatters Claiming
General information
End device ID e2ui-78b3d57ed0a573a86 &
Frequency plan Europe 863-878 MHz (SF9 for RX2 - recom. | IR
LoRaWAN version LoRaWAN Specification 1.@.1 ™
Regional Parametersversion | T5801 Technical Specification 1.8.1 &
Created at Mowv 4, 2022 18:53:43
Activation information
AppEUI 06 08 0O @0 99 6 08 BE <> | R
DevEUI 7@ B3 Db 7FE DB @b 73 AS < | R
AppKey TR I T )

General settings

* Live data

© 18:53:43

Location

Create end device

Maveruotipo Ayaiou Tunua Mnxavikwyv
MAnpodoplakwy Kat ETKOWwWVIaKWY ZUCTNHATWY

See all activity —

Change location settings —
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Arduino MKR 1300-1310 WAN Microcontroller

e To Arduino MKR WAN 1300 Atav n tpwtn tAaketa LoRa® tou kukAodpopnoe amo
NV Arduino, w¢ pla TIPAKTIKI KAl OLKOVOULKA attodoTIKN AVoN PE EAAXLOTECG
ATTIALTAOELG LOXVOC.

¢ To Arduino MKR WAN 1300 pttopei va cuvoeBel pe :
® Arduino loT Cloud
® The Things Network
® AMEC TIAQKETEC XPNOLUOTIOLWVTAC TN AslToupyla ageong cuvdECIUOTNTAC.

Mavemotiuio Awyaiou TuRua Mnxavikwy
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|




Arduino MKR 1300-1310 WAN Microcontroller

Board

Current Rating

Name

DC Current 5V pin (powered
via USB/VIN)

Processor
Clock speed
RTC
Memory SAMD21G18A
[Meploootepeg MAnpodopiec:
https://docs.arduino.cc/hardware/mkr-wan-1300
Maveruotipo Ayaiou Tunua Mnxavikwyv
MAnpodoplakwy Kat ETKOWWVIAKWY ZUCTNHATWY

Arduino® MKR WAN 1300

depends on power supply

48 MHz

32.768 kHz

256KB Flash, 32KB SRAM

ccsli


https://docs.arduino.cc/hardware/mkr-wan-1300
https://docs.arduino.cc/hardware/mkr-wan-1300
https://docs.arduino.cc/hardware/mkr-wan-1300
https://docs.arduino.cc/hardware/mkr-wan-1300
https://docs.arduino.cc/hardware/mkr-wan-1300

Arduino MKR 1300-1310 WAN (Apaotnplotnta)

KaAelote va xpnolyoTiooeTe ToV KWOLKA TIou aag £xel o0&l oto Eclass otov dpdkeAo
“epyaotnplo” otnv 3" doknon Katepaote tov KWdLKka “send data mkrwan”

* Amapaitntn poimobeon yla va avefacoupe ta dedopeva oto TTN peow tov MKR-1300-
1310, eivat o evrotiiopog tou Device EUI tou eival povadikog Kwdikocg (tt.x. serial

number).
*  AdoU eKTEAECOUUE TOV KWOLKA OTIWC eival, oto serial monitor 8a pag epdavioet to device
EUI
Output  Serial Monitor x
13:44:59.202 -> Wel e T MER 1 1 first figuration sketc
13:44:59.202 -> Regilster your favourite LoRa network and we are ready to g
4 - r dul Fersion i D—-07 1.
4 - r device E is: adeloalz33l 10c
122zl .ULG -> 5 ethin ent rong e y lnaoor e near I et

Mavemotriuio Awyaiou TuAua Mnxavikwy
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Arduino MKR 1300-1310 WAN

2 € Ttepirttwon tov dev evrotidoupe to board Arduino MKR WAN 1300-1310
oto Arduino IDE

* KatevBuvopaote otnv evotnta Tools -> Board -> Boards Manager

* ETiAeyoupe amo tov kataloyo va eykataotrjoouvpe to “Arduino SAMD
Boards(32-bits ARM Cortex-M10+)”

* Adou eykataotaBel eTiAeyoupue aro tnv evotnta Tools -> Board
->Arduino SAMD Boards(32-bits ARM Cortex-M10+)-> Arduino MKR
WAN 1300-1310

Mavemotiulo Awyaiou TuAua Mnxavikwy
MAnpodoplakwy Kat ETKovwvIaKwyY ZUoTNHATWY CCS II;




Arduino MKR 1300-1310 WAN

Ektoc amno ta drivers Tou Board Ttou eyKataoTrioape tPonNyoupEVWC, Eival amapaitnto
va eykataotrioovpe kat tn BLBA0Bnkn «MKRWAN.h» Ttpokeluevou va

Tipoypappaticouvpe to board pac. LIBRARY MANAGER

mkrwan

* KatevBuvopaote oto Sketch-> Include Library-> Manage Libraries Type: Al ~
Topic: Adl w

e 2tolMapdBupo ou pag avoiyel oto search bar ypadoupe mkrwan MKRWAN by Arduino
<support@arduino.cc=

: . : Version 1.1.0

* EmAeyoupe to MKRWAN by Arduino kat 1o eykaBloTtoupe. Provides APIs to

communicate with LoRa and

LoRaWAN networks

Support library for MKR WARN
1300/1310

More info

Mavemotriuio Awyaiou TuAua Mnxavikwy
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Arduino MKR 1300-1310 WAN (Apaotnplotnta)

*  Adou Bpnkaue to device EUl kateuvBuvopaote oto TNN mtpokepevou va ptidéovpe veo
application

THE THINGS o, g i N srprise i
NETWORK Learn Hardware Forum Community Conference Enterprise Login I

AR . *
" e . R
4 .
v ak N
b

We are a global collaborative
Internet of Things ecosystem

that creates networks, devices ""-.LI : " . } ;
and solutions using | 2
LoRaWAN®. :
| ‘ T ¢
=

2UVOECHOC LOTOTOTIOU : Link

Maveruotipo Awyaiov Tunua Mnxavikwyv
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https://www.thethingsnetwork.org/

TTN loT Device

u tsipisdemoapp

Provisioning information

=0 Overview JoinEUI (D~

60 00 60 00 OO 00 60 0  Reset

A End devices This end device can be registered on the network

=] Livedata DevEUI® * r ’
apoupe
70 B3 D5 7E D@ @5 73 AB 5/50 used <€ p q) , “
< ? Payload formatters W T[pOO'SKTlKa TO DeV
AppKey @+ 5
pR Integrations e EUI Tou BanaUS

DB DF 17 72 02 A2 C7 46 80 93 FO D4 80 EB 2A BA ) Generate

T(PONYOUHEVWC

=w Collaborators End device ID® *

eui-70b3d57ed00573a6
Or AP keys
This value is automatically prefilled using the DevEUI

L3 General settings After registration
®  View registered end device

Register another end device of this type

Maveruotipo Awyaiou Tunua Mnxavikwyv
MAnpodoplakwy Kat ETKowvwviakwy ZUoTNHATWY CCS I||I |



2
m THE THINGS STACK

e Community Edition
HETWORK

u tsipisdemoapp

BE Overview
A End devices

(=) Livedata

<» Payload formatters v

TTN loT Device

B3 Overview O Applications & Gateways & Organizations

Applications > tsipisdemoapp > End devices

@ EUL community

Fair use policy applies @

leftsipis =

End devices (1) Q, search =+ Import end devices + Add end device
D = Name < DevEUI JoinEUI Last activity
eui-70b3d57ed00573a6 TBEB3 D5 FTEDR @5 73 A8 | g PG 00 @0 @ 00 B B0 00 | [ Newver

Maveruotipo Ayaiou Tunua Mnxavikwyv
MAnpodoplakwy Kat ETKOWWVIAKWY ZUCTNHATWY
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<>

tsipisdemoapp

Qverview

End devices

Live data

Payload formatters

Integrations

Collaborators

API keys

General settings

TTN loT Device

EUul-I/UpP3IUD I eUuuvuvd i 340
ID: eui-T0b3d57ed00573a6

Tnfa <nfa

Live data

General information
End device ID
Frequency plan
LoRaWAN version

Regional Parameters version

Created at

No activity yet @

Messaging Location Payload formatters Claiming General settings
» Live data
eui-70b3d57ed@EET3a6 ™ ° 18:53:43 Create end device

Europe 563-878 MHz (5F% for R¥Z - recoma. &

LoRaWAN Specification 1.8.1 I3

TSE@1 Technical Specification 1.0.1 &

MNov 4, 2022 18:53:43

Activation infermation

AppEUI

DevEUI

AppKey

Locatjon

06 20 00 00 00 40 88 BB < |

7B B3 Db 7E DB @5 73 AS < | g

B L L T T [ I

MAnpodoplakwy Kat ETKOWWVIAKWY ZUCTNHATWY
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Change location settings —
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Apaotnplotnta

Activation information

8 B3 D5 7E D@ @5 73 A3 o [

17

18 String appEul="10000000000000omsx” )

19

28 String appKey="100000000000000000000000000x"
21

22 String devEUL="1xx00coaoodanaonaananon” ;
23

A4

v

\ 4

modem. setPort(1);

2o €0 G0
LI T v ]

ANAloupe tnv Bupa pe Baon
TOV UTTOAOYLOTH] TTOU
Bplokopaote Tu.X. (1°6 D
UTTOAOYLOTHC ATTO TIAVW

aplotepa port=1)

Maveruotipo Awyaiov Tunua Mnxavikwy
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Apaotnplotnta

AdOoU TPOTIOTIOLNOETE TOV KWOLKA KATAANAQ pe BAon tnv tponyoupevn
dladavelq, avepfaote Tov Kwodlka oto Board.

* Tumapatnpeite otnv KapteAa Live Data oto TTN ;

Maveruotnuo Awyaiou TuRua Mnxavikwy
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Apaotnplotnta

[MpoKEEVOL VA ATTOKWOLKOTIOICOUE TO PVUHA TIOU OTEIAAPE TIPETIEL VA
TpoTtoTtolrjooupe tov payload formatter:

function decodeUplink(input)
{ return{ data:{ number:input.bytes[0] }
, warnings:[], errors:[] }}

eui-a8610a323339910c

ID: cui-a8610a323339910c¢

™1 1 e Lastactivity 7 secondsago @

Overview Live data Messaging Location Payload formatters Claiming General settings

Time Type Data preview
V' 15:14:56 Schedule data downlink for t.. DevAddr: | 26 @B 41 75 | <> B Rx1 Delay: 5
P 15:14:55 Forward uplink data messade DevAddr: 26084175 | <> | IR Payload: § number: 12 ¥ @C <> ™
M 15:14:55 Successfully processed data .. DevAddr: | 26 084175 | <> | IR

Maveruotipo Awyaiou Tunua Mnxavikwyv
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